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BAB II  

KAJIAN  TEORITIK DAN  KERANGKA B ERPIKIR  

  

2.1. Kajian Teoritik  

2.1.1. Mesin Press 

Pada proses produksi pembuatan komponen-komponen pada pengunci 

pintu, dari bahan material sampai keluar menjadi barang jadi, material 

tersebut harus melewati berbagai tahap proses. Salah satunya adalah 

pemotongan pada mesin press. Contoh mesin press yang ada pada industri 

menggunakan hydraulic dapat di lihat pada gambar 2.1. di bawah. 

 

 
 

Gambar 2.1. Contoh Mesin Press 
Sumber : http://planetcopas.blogspot.com/2012/05/prinsip-kerja-mesin-stamping-

press.html  

 

Pada dasarnya proses pengepresan menggunakan teknik tumbukan yaitu 

dengan menekan atau menumbuk suatu material pada suatu mesin menjadi 

bentuk yang diiginkan. Mesin press adalah mesin yang menompang sebuah 

landasan dan sebuah penumbuk, subuah sumber tenaga dan suatu mekanisme 

http://planetcopas.blogspot.com/2012/05/prinsip-kerja-mesin-stamping-press.html
http://planetcopas.blogspot.com/2012/05/prinsip-kerja-mesin-stamping-press.html
http://2.bp.blogspot.com/__7FfzQdvc2s/TH_S4paqdjI/AAAAAAAAAGk/dwsLFBRc9tk/s400/mepress.bmp
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yang menyebabkan penumbuk bergerak lurus dan tegak menuju landasannya. 

Proses pembentukan dan pemotongan pada mesin press tergantung pada 

cetakan yang digunakan. Penggolongan sederhana yang mencakup jenis 

cetakan itu sendiri adalah sebagai berikut : 

 

2.1.1.1. Proses Pembentukan 

Proses pembentukan adalah proses dimana logam ditekan dengan 

tekanan yang besar sampai dengan batas kemampuan parts tersebut berubah 

bentuk seperti yang diinginkan. Proses pembentukan dapat dikelompokan lagi 

menjadi : 

a. Draw yaitu suatu proses pembentukan material. Draw ini merupakan 

awal proses pada mesin press atau stemping sebelum dilanjutkan. 

b. Bending yaitu proses penekukan part yang hanya dilakukan satu kali 

per stoke. 

c. Flange yaitu proses penekukan material yang lebih dari 1 pada setiap 

stoke. 

d. Curling yaitu suatu proses pembentukan diameter. 

e. Burring yaitu proses penekukan keliling pada bagian dalam lubang. 

f. Bulge yaitu proses pembesaran dari diameter pipa. 

 

2.1.1.2. Proses Pemotongan 

Proses pemotongan adalah proses dimana material dipotong sesuai 

dengan ukuran yang diinginkan agar material tersebut dapat dikerjakan 
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kedalam proses berikutnya. Proses pemotongan ini dikelompokan lagi 

menjadi 

a. Cutting yaitu suatu proses pemotongan material yang masih berbentuk 

lembaran (blank material). 

b. Trim yaitu sutu proses pemotongan material pada bagian tepi.  

c. Pierce yaitu suatu proses pembuatan lubang pada material. 

d. Cam Trim / Pierce yaitu suatu proses pembuatan lubang pada material. 

e. Separate yaitu suatu proses pemotongan pelat menjadi 2 bagian. 

f. Slit yaitu suatu proses penyobekan sebagian material. 

g. Nocthing yaitu suatu proses pemotongan sebagian material atau sebuah 

coakan kecil.
4
 

 

2.1.2. Pengertian Prototype 

Menurut kamus besar bahasa Indonesia prototype memiliki arti model 

yang mula (model asli) yang menjadi contoh atau standar ukuran dari sebuah 

entitas. Dalam bidang desain, sebuah prototype dibuat sebelum 

dikembangkan atau justru dibuat khusus untuk pengembangan sebelum dibuat 

dalam skala sebenarnya atau sebelum diproduksi massal. 

Prototype bisa diartikan juga sebagai bentuk awalnya saja dan tidak 

menutup kemungkinan bisa dikembangkan menjadi sekala yang lebih besar. 

Jadi jangan heran apabila banyak prototype yang dibuat dengan ukuran yang 

                                                           
4
 http://planetcopas.blogspot.com/2012/05/prinsip-kerja-mesin-stamping-  

press.html 

http://planetcopas.blogspot.com/2012/05/prinsip-kerja-mesin-stamping-%20%20press.html
http://planetcopas.blogspot.com/2012/05/prinsip-kerja-mesin-stamping-%20%20press.html
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sangat kecil, ini bertujuan untuk membuat sebuah model awal sebuah 

prototype yaitu: 

1. Throw-away 

Prototype dibuat dan dites. pengalaman yang diperoleh pembuatan 

prototype digunakan untuk membuatan produk  akhir kemudian prototype 

tersebut dibuang (tidak dipakai). 

2. Evolutionary 

Pada metode ini, prototipenya tidak dibuang tetapi digunakan iterasi 

desainnya berikutnya. Dalam hal ini system atau produk yang sebenarnya 

dipandang sebagai evolusi dari versi awal sangat terbatas menuju produk 

final atau produk akhir. 

 

2.1.3. PLC (Programmable Logic Controller) 

PLC pertamakali diperkenalkan pada tahun 1960-an di Divisi Mobil 

Tua Perusahaan Motor Modicon, MODICON 084 merupakan PLC pertama di 

dunia yang digunakan pada produk komersil. Alasan utama perancangan PLC 

adalah untuk menghilangkan beban ongkos perawatan dan penggantian sistem 

kontrol mesin berbasis relay, karena setiap kebutuhan produksi berubah maka 

demikian pula dengan sistem kontrolnya. Karena relay merupakan alat 

mekanik, maka tentu saja memiliki umur oprasi atau masa penggunaan dari 

peralatan yang terbatas, dan akhirnya mengakibatkan jadwal perawatan yang 

ketat. 
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 Menurut Drs. Suyanto hingga akhir tahun 1970 sistem otomasi mesin 

dikendalikan oleh elektromagnetik atau biasa disebut dengan sistem 

konvensional.  Jika sistem kontrol sangat kompleks, dapat dibayangkan 

berapa banyak relay yang dibutuhkan sebagai komponen kontrolnya. Dengan 

semangkin meningkatnya perkembangan teknologi, tugas-tugas pengendalian 

dibuat dalam bentuk pengendalian terprogram yang dapat dilakukan antara 

lain menggunakan PLC. Dengan menggunakan PLC, sinyal dari berbagai 

peralatan luar di interfis sehingga fleksibel dalam mewujudkan sistem 

kendali. Disamping itu, kemampuannya dalam komunikasi  jaringan 

memungkinkan penerapan yang luas dalam berbagai operasi pengendalian 

sistem. Contoh panel konvensional dapat dilihat pada gambar 2.2. 

 

  

Gambar 2.2. Panel Kontrol Konvensional 
Sumber:http://www.panduaninstalasi.com/monitoring%20automation%20sistem.phphttp:

///2011/06/system-control-dasar-menggunakan.html 

 

Sistem PLC pertama dikembangkan dari komputer konvensional pada 

akhir tahun 1960 dan awal 1970. Awalnya, PLC banyak dipasang pada plane 

automotive dengan menggunakan teknik otomasi baru untuk mempersingkat 

http://www.panduaninstalasi.com/monitoring%20automation%20sistem.phphttp:/2011/06/system-control-dasar-menggunakan.html
http://www.panduaninstalasi.com/monitoring%20automation%20sistem.phphttp:/2011/06/system-control-dasar-menggunakan.html
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waktu dari prosedur pengawatan konvensional. Prosedur reprogram 

(pemrograman ulang) PLC telah menggantikan rewiring (instalasi ulang) dari 

panel yang penuh kabel, relay, timer, dan komponen lainnya. Jadi pada 

intinya, PLC bisa membantu mengurangi waktu rewiring yang cukup rumit 

dan lama digantikan dengan cara reprogram yang lebih cepat. 

 Dalam sistem otomasi, PLC merupakan otak sistem kendali dalam 

program yang disimpan dalam memori PLC, dalam eksekusinya, PLC dapat 

memonitor keadaan sistem melalui sinyal dari peralatan input, kemudian 

didasarkan atas logika program menentukan rangkaian aksi pengendalian 

peralatan output luar. PLC dapat juga digunakan untuk mengendalikan tugas-

tugas sederhana yang berulang-ulang, atau diinterkoneksi dengan yang lain 

menggunakan komputer melalui jenis jaringan komunikasi untuk 

mengintegrasikan pengendalian proses yang kompleks. 

Tiap-tiap PLC pada dasarnya merupakan sebuah microcontroller yang 

dilengkapi dengan peripheral yang berupa masukan (input) digital, keluaran 

(output) berupa digital atau relay. Perangkat program lunak (software) sama 

sekali berbeda dengan pascal, basic, bahasa C dan lain-lain. Tetapi 

menggunakan program ladder diagram.
 5
  

Akan  tetapi, meskipun PLC dapat mengganti seluruh rangkaian kontrol 

konvensional dengan relay kontak, tetapi terdapat beberapa permasalahan 

yang menjadi perbandingan dalam  penggunaannya sesuai karakteristik dan 

fungsinya masing-masing dapat dilihat pada table 2.1. pada hal 14. 

                                                           
5
 Syufrijal, op. cit , hlm. 3-4. 
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Tabel 2.1. Perbandingan Sistem Kontrol Konvensional dan PLC 

No Permasalahan Konvensional PLC 

1 
Keindahan penulisan rangkaian 

kontrol 
Dari atas ke bawah Dari kiri ke kanan 

2 Pembacaan rangkaian kontrol Dari atas ke bawah Dari kiri ke kanan 

3 
Hubungan kontak-kontak 

peralatan kontrol 

Secara elektrik dengan 

kabel penghubung 

Secara elektronik, tanpa kabel 

penghubng 

4 
Kapasitas kontak peralatan 

kontrol 
Terbatas 

Tak terbatas ( sesuai jumlah 

memori) 

5 
Hubungan rangkaian kontrol 

dengan peralatan 

Umumnya dilakukan 

bersamaan 

Penginstalasian dapat 

dilakukan terpisah 

6 Pembacaan rangkaian kontrol 
Meliputi peralatan I/O 

luar dan relay kontrolnya 

Lebih banyak menyangkut 

I/O saja 

7 Pengecakan rangkaian kontrol 
Lebih sulit karena tidak 

dapat dimonitor 

Lebih mudah tidak dapat 

dimonitor 

8 Merangkai rangkaian kontrol 

Kebih sulit karena harus 

dilakukan pengawatan 

per komponen 

Lebih mudah dan cepat 

karena dilakukan 

denganpemrograman 

9 Modifikasi rangkaian kontrol 

Sulit dilakukan karena 

harus mengubah 

pengawatan 

Mudah dilakukan dengan 

mengubah program 

10 Keandalan kontak rangkaian 

Kurang baik karena 

kontak-kontaknya 

mudah aus atau korosi 

Baik tidak mengalami aus 

atau korosi 

11 Respons kontak Relatif lambat Sangat cepat 

 a.  a.  a.  

12 

Biaya pembuatan panel kontrol 

a) Untuk kontrol yang 

kompleks 

b) Untuk kontrol yang 

sederhana 

a) Relatif mahal 

b) Lebih murah 

a) Relatif murah 

b) Lebih mahal 

 

 

2.1.3.1. Pengertian PLC 

PLC adalah sebuah alat kontrol yang bekerja berdasarkan pada 

pemrograman dan eksekusi instruksi logika
6
. Menurut NEMA (National 

Electrical Manufacture Association), PLC adalah sebuah perangkat 

elektronika digital menggunakan memori yang dapat diprogram sebagai 

penyimpan internal dan menyediakan instruksi-instruksi untuk menjalankan 

                                                           
6
 Iwan Setiawan, Programmable Logic Controller (PLC) dan Teknik Perancangan Sistem Kontrol, 

(Cet.1 ; Yogyakarta: ANDI, 2006), hlm. 1. 
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fungsi-fungsi yang spesifik seperti logic, sequence, timing, counting, 

arithmetic. 

Definisi sederhana dari PLC, yaitu Programmable (dapat 

diprogram), Logic (bekerja berdasarkan logika yang dibuat, logika disini 

biasanya menunjuk   pada logika Boolean yang hanya terdiri dari dua 

keadaan ON dan OFF), Controller (pengendali dari suatu sistem).
7
 macam-

macam bentuk fisik PLC dapat dilihat pada gambar 2.3. 

 
 

Gambar 2.3. Bentuk Fisik Beberapa PLC 
 Sumber : www.Google.com. Diakses pada tanggal 24 Juni 2014. 

 

PLC secara bahasa berarti pengontrol logika yang dapat diprogram 

PLC menyerupai komputer elektronik yang mudah digunakan (user 

friendly) yang memiliki fungsi kendali untuk berbagai tipe dan tingkat 

kesulitan yang beraneka ragam.
8
 

Sebuah PLC berisi  CPU (central processing unit) atau otak dari 

PLC yang berisi sebuah aplikasi program, modul interface input dan output 

                                                           
7
 Handy Wicaksono, loc. cit. 

8
 Hanif Said, op. cit., hlm. 2. 

http://www.google.com/
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yang terhubung secara langsung ke field I/O devices dan lebih 

lengkapnya PLC dapat diartikan  sebuah alat kontrol yang bekerja 

berdasarkan pada pemprograman dan eksekusi instruksi logika. 

 

2.1.3.2. Perinsip Kerja PLC 

Pada dasarnya PLC beroperasi dengan cara memeriksa input dari 

sebuah proses guna mengetahui statusnya kemudian sinyal input ini diproses 

berdasarkan instruksi logika yang telah diprogram dalam memori. Dan 

sebagai hasilnya adalah berupa sinyal output.  

 
Untuk melaksanakan sebagai kontrol sistem, PLC ini didukung 

oleh perangkat lunak yang merupakan bagian peting dari PLC. Dalam 

merancang suatu sistem kendali dibutuhkan pendekatan-pendekatan 

sistematis dengan prosedur sebagai berikut : 

a. Rancangan Sistem Kendali 

Dalam tahapan ini perancang harus menentukan terlebih dahulu sistem 

apa yang akan dikendalikan dan proses bagaimana yang akan ditempuh. 

Sistem yang dikendalikan dapat berupa peralatan mesin ataupun proses 

yang terintegrasi yang sering secara umum disebut dengan controlled 

system. 

b. Penentuan I/O 

 Pada tahap ini semua piranti masukan dan keluaran eksternal yang akan 

dihubungkan PLC harus ditentukan. Piranti masukan dapat berupa saklar, 
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sensor, valve dan lain-lain sedangkan piranti keluaran dapat berupa 

solenoid katup elektromagnetik dan lain-lain. 

c. Perancangan Program (Program Design) 

Setelah ditentukan input dan output maka dilanjutkan  dengan proses 

merancang program dalam bentuk ladder diagram dengan mengikuti 

aturan dan urutan operasi sistem kendali. 

d. Pemprograman (Programming) 

e. Menjalankan Sistem (Run The System) 

 Pada tahapan ini perlu dideteksi adanya kesalahan-kesalahan satu 

persatu (debug), dan menguji secara cermat sampai kita memastikan 

bahwa sistem aman untuk dijalankan.
 9
 

 

Gambar 2.4. Prinsip Kerja PLC 

Sumber : Andi, ñPrinsip kerja PLCò, PLC, 

http://rudisaputra06.blogspot.com/2013/01/prinsip-kerja-plc.html Diakses pada tanggal 

24 November 2013 

 

                                                           
9
 Juni Ardi, ñPLC (Programmable Logic Controller),ò Juare97ôs, 

http://juare97.wordpress.com/2007/10/20/plc-programmable-logic-controller, diakses tanggal : 14 

Maret  2013. 

http://rudisaputra06.blogspot.com/2013/01/prinsip-kerja-plc.html
http://juare97.wordpress.com/2007/10/20/plc-programmable-logic-controller
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Gambar 2.4. pada hal 17 adalah contoh diagram blok dari inpu dan 

output PLC. Hasil dari prosesnya adalah output, sinyal output inilah 

yang dipakai untuk mengendalikan peralatan atau mesin. Kerja dari 

PLC sepenuhnya tergantung dari program yang terdapat dalam memori. 

 

2.1.3.3. Bagian-Bagian PLC 

Bagian PLC pada prinsipnya tidak jauh berbeda dari perangkat 

keras (hardware) yang dimiliki oleh komputer, yaitu terdiri dari CPU 

(Central Processing Unit), model input & model output, memori PLC, catu 

daya, peralatan input, dan peralatan output.
10

 Bagian-bagian yang terpadat 

pada PLC yaitu : 

a. CPU (Central Processing Unit) 

 CPU merupakan otak dari sebuah kontroller PLC yang biasanya berupa 

mikrokontroler. PLC terdiri atas CPU (Central Processing Unit), memori, 

modul, interface input dan output program kendali disimpan dalam memori 

program pengendalian PLC, sehingga saat sinyal input dari input hidup 

maka timbul respon yang sesuai. Respon yang sesuai umumnya 

menghidupkan sinyal output pada peralatan output. 

 CPU adalah microprocessor yang mengkoordinasikan kerja sistem 

PLC. Microprocessor mengesekusi program, memproses sinyal 

input/output, dan berkomunikasi dengan peralatan luar. Tugas dari CPU 

dalam PLC adalah mengontrol dan mensupervisi semua operasi PLC, 

sebuah komunikasi internal atau bus system membawa informasi dari dan 

                                                           
10

 Syufrijal, op, cit., hlm6. 
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ke CPU, I/O dan memori. CPU dihubungkan ke memori dan I/O oleh tiga 

macam bus, yaitu : 

1. Control Bus 

 Fungsi dari control bus adalah mengijinkan CPU mengontrol 

kapan harus menerima atau mengirimkan informasi dari salah satu, 

yaitu I/O atau memori 

2. Address Bus 

 Fungsi dari Address Bus mengijinkan CPU untuk menetapkan 

alamat untuk membuka komunikasi pada daerah tertentu yang ada di 

memori atau I/O. 

3. Data Bus 

 Fungsi dari Data Bus adalah mengijinkan CPU, memori dan I/O 

untuk saling tukar menukar informasi (data). Jumlah garis paralel dalam 

address bus ditentukan oleh besarnya lokasi memori yang dapat 

dialamatkan, sedangkan ukuran dari data bus menentukan besarnya 

jumlah bit informasi yang dapat dilewatkan antara CPU, memori dan 

I/O. 

b. Memori 

 Memori sistem ini berfungsi untuk menyimpan sistem operasi dan juga 

untuk menyimpan program yang harus dijalankan dalam bentuk biner, hasil 

terjemahan leader diagram yang dibuat oleh pemprogram. Data-data yang 

terdapat pada memori dapat diubah (dikosongkan atau dihapus). Memori 

pengguna terdiri dari bebrapa blok yang memiliki fungsi khusus. Beberapa 



20 
 

bagian pada memori digunakan untuk menyimpan status input dan output. 

Status yang sesunguhnya dari input maupun output akan disimpan sebagai 

logic/bilangan 0 dan 1. Masing-masing input berkaitan dengan bit yang 

terdapat dalam memori. Bagian lain dalam memori digunakan untuk 

menyimpan variabel yang telah dituliskan di dalam program.  

 Memori adalah bagian penting dalam PLC, deretan instruksi atau 

program dan data disimpan dalam sistem memori. Dua pertimbangan pokok 

yang melandasi pemakaian memori untuk menyimpan program terapan 

adalah kemampuan menyimpan program (secara permanen atau tidak) dan 

fasilitas untuk perubahan. Dalam uraian berikut ini, terdapat dua jenis 

memori yaitu ROM (Read Only Memory) dan RAM (Random Access 

Memory).
11

 

1) ROM (Read Only Memory) 

 ROM dirancang untuk menyimpan secara permanen suatu program 

yang sudah pasti. Dalam kondisi biasa, program ini tidak dapat diubah 

sesuai namanya hanya bisa dibaca saja. ROM umumnya sangat kebal 

terhadap noise listrik maupun kehilangan catu daya listik. Sebagai 

memori untuk aplikasi ROM kurang tepat, namun bila memerlukan 

sejumlah data yang tepat dan pasti, data ini dapat disimpan didalam 

ROM untuk menghemat waktu dan biaya. 

 Pemprograman ROM dilakukan di pabrik pembuat ROM. Jenis 

ROM yaitu PROM (Programmable Read Only Memory), EPROM 

                                                           
11

 Ibid., hlm. 7. 
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(Erasable Programmable Read Only Memory), EAROM (Electrically 

Alterable Read Only Memory), dan EEPROM (Electrically Erasable 

Programmable Read Only Memory). 

2) RAM (Random Access Memory) 

 RAM dikenal pula sebagai Read/Write Memory, dirancang agar 

informasi data dapat dimasukan ke dalam memori dan dapat dipanggil 

kembali setiap saat. Jenis RAM ada dua, yaitu Volatile Random Access 

Memory  dan Non Volatile Random Access Memory. Dimana Volatile 

Random Access Memory isinya akan hilang apabila arus listrik diputus, 

oleh karena itu diperlukan battery pendukung untuk mempertahankan 

isi memori selama arus listrik dari catu daya tidak bekerja. Dan Non 

Volatile Random Access Memory bila catu daya dilepas dari kontroller, 

data di dalam RAM akan hilang, tetapi data tersebut akan terisi kembali 

oleh proses Recall, yaitu data di dalam EEPROM masuk ke RAM. 

c. Pemprograman PLC 

 Kontroller PLC dapat diprogram melalui komputer, namun ada juga 

cara lain untuk memprogramnya yaitu dengan cara memprogram manual 

atau yang biasa disebut dengan konsol (console). Untuk melakukan 

pemrograman manual ini dibutuhkan software yang sesuai dengan produk 

PLCnya, karena masing-masing produk PLC membutuhkan softwarenya 

sendiri-sendiri.  

 Dalam memprogram ulang PLC sangat penting diperhatikan bahwa saat 

sistem diperbaiki program yang benar dan sesuai harus disimpan kedalam 

PLC lagi. Dan juga penting dilakukan pemeriksaan program PLC apakah 
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selama penyimpanan tidak terjadi perubahan atau sebaliknya, apakah 

program sudah berjalan benar atau tidak. Karena dengan pemeriksaan ini 

dapat menghindari situasi berbahaya dalam ruang produksi (pabrik). 

d. Power Supply PLC 

Power supply digunakan untuk memberikan aliran daya ke seluruh 

bagian PLC termasuk CPU, Memori, dan lain-lain. Rata-rata PLC bekerja 

dengan daya 24 VDC atau 220 VAC. PLC adalah sebuah peralatan digital 

dan setiap peralatan digital membutuhkan catu daya DC. Catu daya ini dapat 

dicatu dari luar, atau dalam PLC itu sendiri. PLC tipe modular 

membutuhkan catu daya dari luar, sedangkan PLC tipe compect catu daya 

tersedia pada unit PLC. Bentuk PLC tipe compect dan tipe modular dapat 

dilihat pada gambar 2.5.  

 

 
 

Gambar  2.5. PLC tipe modular dan tipe PLC compact 
Sumber : Google Image 
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e. Modul Input dan Modul Output (Modul I/O) 

 Modul I/O merupakan suatu peralatan pada PLC yang berfungsi sebagai 

penghubung antara CPU PLC dengan peralatan input dan output yang 

berasal dari luar PLC. Untuk PLC tipe compact, modul I/O terpasang 

permanen dan menyatu dengan CPU dan catu daya PLC. Sedangkan untuk 

PLC tipe modular, modul I/O terpisah dengan CPU PLC sehingga lebih 

fleksibel untuk dilepas. Dan dipasang kembali. 

Terdapat dua jenis modul input dan output, yaitu analog dan digital, 

karena keduanya menentukan sinyal yang diterima atau dihasilkan oleh 

peralatan. Peralatan input dan output digital menghasilkan sinyal 0 dan 1, 

sedangkan peralatan input analog menghasilkan sinyal range tertentu (misal 

: 4-20 mA, 0-10V). Demikian juga peralatan output digital diaktifkan oleh 

sinyal 0 dan 1, sedangkan peralatan output analog dapat diaktifkan oleh 

sinyal dengan range tertentu.
12

 

 

CPUInput

i

LED Photo Transistor  
 

Gambar 2.6.  Rangkaian Modul Input PLC  

Sumber : Syufrijal, Konsep, Aplikasi dan Komunikasi Jaringan PLC, (Universitas Negeri 

Jakarta : 2012) 

 

                                                           
12

 Handy Wicaksono, op. cit., hlm. 3. 
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 Dari gambar 2.6. pada hal 23 dapat dilihat bahwa modul input tersebut 

berfungsi untuk mengkonversi atau mengubah sinyal-sinyal masukan dari 

peralatan input luar PLC sesuai dengan tegangan kerja CPU PLC. Hal 

tersebut dilakukan dengan menggunakan rrangkaian opto-isolator. 

 Peralatan input akan memberikan sinyal untuk menghidupkan LED, 

akibatnya photo transistor akan menerima cahaya dan menghantarkan arus 

dan CPU akan merespon hal tersebut. 

 

OutputCPU

i

LED Photo Transistor  
 

Gambar 2.7.  Rangkaian Modul Output PLC 

Sumber : Syufrijal, Konsep, Aplikasi dan Komunikasi Jaringan PLC, (Universitas 

Negeri Jakarta : 2012) 

 

 Berbeda dengan modul input, dari gambar 2.7. dapat dilihat bahwa 

sekarang yang memberikan sinyal untuk menghidupkan LED (Light 

Emitting Diode) adalah menjadi tugas CPU PLC, akibatnya photo transistor 

akan menerima cahaya dan menghantarkan arus dan peralatan output akan 

merespon hal tersebut. 

f. Peralatan Input PLC 

Kecerdasan suatu sistem yang terotomasi sangat bergantung pada 

kemampuan sebuah PLC untuk membaca sinyal dari berbagai macam jenis 
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sensor dan piranti input yang lain. Untuk mendeteksi proses yang sedang 

terjdi  maka dibutuhkan sensor-sensor yang tepat untuk masing-masing 

kondisi. Sinyal-sinyal yang telah terdeteksi sensor tersebut dapat berupa 

logic (ON atau OFF) maupun analog. Pada PLC kecil biasanya hanya 

mampu menerima input digital saja namun untuk PLC besar mampu 

menerima input analog dari unit khusus yang sesuai dengan PLC nya. 

Peralatan input adalah yang memberikan sinyal kepada PLC dan 

selanjutnya PLC memproses sinyal tersebut untuk mengendalikan peralatan 

output, peralatan input itu antara lain : 

1. Berbagai jenis saklar, misalnya tombol, saklar togel, saklar batas, 

saklar level, saklar tekan. 

2. Berbagai jenis sensor, misal sensor cahaya, sensor suhu, sensor 

level.
13

  

g. Interfacing Input 

Interfacing input berada di jalur input dan CPU. Tujuan elemen ini 

adalah untuk melindungi CPU dari sinyal-sinyal yang tidak diinginkan dan 

dapat merusak CPU tersebut. Modul interfacing input ini berfungsi untuk 

mengkonversi sinyal-sinyal input dari luar ke sinyal yang sesuai dengan 

tegangan kerja CPU. Contoh input tegangan pada sensor yaitu 22 VDC 

maka harus di konversikan ke 5 VDC agar sesuai dengan tegangan kerja 

CPU. 

 

 

                                                           
13

 Ibid., hlm 3-6 
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h. Peralatan Output PLC 

Jika sistem terotomasi memiliki input pastinya juga memiliki output. 

Tidak akan lengkap jika tidak ada jalur input yang digunakan untuk 

menghubungkan ke alat-alat eksternal. Contoh alat yang banyak digunakan 

yaitu motor, selenoid, relay, lampu indikator, speaker, dan lainnya. Output 

ini dapat berupa analog maupun digital. Output digital akan dianalogikan 

seperti saklar yang dapat memutus atau menyambungkan jalur. 

 Untuk output analog contohnya dapat digunakan merubah tegangan 

untuk pengendalian motor secara regulasi linier sehingga memperoleh 

kecepatan yang diinginkan. Sistem otomasi tidak lengkap tanpa adanya 

peralatan output yang dikendaliakan. Peralatan output itu misalnya 

kontaktor, motor listrik, lampu, buzer. 

i. Interfacing output 

Seperti juga interfacing input, output juga memerlukan interfacing yang 

sama digunakan untuk memberikan perlindungan antara CPU dengan 

peralatan eksternal agar tidak terjadi kerusakan pada CPU-nya. 

j. Jalur Tambahan 

Peralatan penunjang adalah peralatan yang digunakan dalam sistem 

kendali PLC, tetapi bukan merupakan bagian dari sistem secara nyata. 

Maksudnya, peralatan penunjang digunakan untuk keperluan tertentu yang 

tidak terkait dengan aktifitas pengendalian. Peralatan penunjang itu, antara 

lain : 

1. Berbagai jenis alat pemrograman, yaitu komputer, software ladder, 

console programming, programmable terminal, dan sebagainya. 
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2. Berbagai software ladder, yaitu SSS, LSS Syswin dan CX 

Programmer 

3. Berbagai jenis memori luar (external memory), yaitu disket, CD 

ROM, flash disk. 

4. Berbagai alat pencetak dalam sistem komputer, misalnya printer dan 

Plotter. 

 

2.1.3.4. Struktur Area Memori PLC Omron CJ1 

 PLC omron tipe CJ1 mempunyai 9 daerah memori dan area 

memorinya dapat dilihat di bawah ini :  

a. Daerah CIO (Core I/O) 

1. Input dan Output (I/O) area 

 Daerah I/O ini digunakan untuk mengalokasikan alamat peralatan 

input dan output. Alamat input dan output terdiri dari 1.280 bit yaitu 

dimulai dari CIO 000000 ï CIO 007915 atau 80 word yaitu CIO 0000 ï 

CIO 0079. 

2. Link area 

Bit-bit pada link area ini dapat digunakan untuk sistem data link 

dan controller link. Alamat link area terdiri dari 3.200 bit yaitu dimulai 

dari CIO 100000-CIO 119915 atau 200 word yaitu CIO 1000-CIO 

1199. 

3. CPU bus unit area 

 Alamat CPU bus unit area ini terdiri dari 6.400 bit yaitu dimulai 

dari CIO 150000-CIO 189915 atau 400 word yaitu CIO 1500-CIO 
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1899. Pengalamatan CPU bus unit tergantung dari setting nomor 

unitnya. Untuk nomor unit 0 maka alamat wordnya adalah CIO 1500-

CIO 1524, sedangkan untuk nomer unit 1 maka alamat wordnya adalah 

CIO 1525-CIO 1549, begitu seterusnya sampai ketika nomer setting 

unitnya 15 maka alamat wordnya adalah CIO 1875-CIO 1899. 

4. Special I/O  unit area 

 Alamat spesial I/O unit area terdiri dari 15.360 bit yaitu dimulai 

dari CIO 20000-CIO 295915 atau 960 word yaitu CIO 2000-CIO 2959. 

Pengalamatan spesial I/O unit tergantung dari setting nomer unitnya. 

Untuk nomor unit 0 maka alamat wordnya adalah CIO 2000-CIO 2009, 

sedangkan untuk nomor unit 1 maka alamat wordnya adalah CIO 2010-

CIO 2019, begitu seterusnya sampai ketika setting nomor unitnya 95 

maka alamat wordnya adalah CIO2950-CIO 2959. 

5. Serial PLC Link Area 

 Alamat PLC Link area ini terdiri dari 1.440 bit yaitu dimulai dari 

CIO 310000-CIO 318915 atau 90 word yaitu CIO 3100-CIO 3189. 

6. DeviceNet area 

 Alamat DeviceNet area ini terdiri dari 9.600 bit yaitu dimulai dari 

CIO 320000-CIO 379915 atau 600 word yaitu CIO 3200-CIO 37900. 

7. Internal I/O area 

 Alamat Internal I/O area ini terdiri dari 4.800 bit yaitu dimulai dari 

CIO 120000-CIO 149915 atau 300 word yaitu dimulai dari CIO 1200 
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CIO 1499 dan 37.504 bit dimulai dari CIO 380000-CIO 614315 atau 

2.344 word yaitu dimulai dari CIO 3800-CIO 6143.
 14

 

 

2.1.3.5. Intstruksi-instruksi dalam pemprograman PLC 

Sebelum memasuki instruksi-instruksi dalam pemrograman PLC 

akan dibahas unsur-unsur program, program kendali PLC terdiri atas tiga 

unsur yaitu : alamat, instruksi, dan operand. 

a. Alamat 

 Alamat adalah nomor yang menunjukan lokasi, instruksi, atau data 

dalam daerah memori. Instruksi harus disusun secara berurutan dan 

menempatkannya dalam alamat yang tepat sehinga seluruh instruksi 

dilaksanakan mulai dari alamat terendah hingga alamat tertinggi dalam 

program. 

b. Instruksi  

Instruksi adalah perintah yang harus dilakukan PLC. PLC hanya 

dapat melaksanakan instruksi yang ditulis dengan menggukan ejaan 

yang sesuai. Oleh karena itu, pembuat program harus memperhatikan 

tata cara penulisan instruksi. 

c. Operand 

 Operand adalah nilai berupa angka yang ditetapkan sebagai data 

yang digunakan untuk suatu instruksi. Operand dapat dimasukkan 

                                                           
14

 Syufrijal, loc. cit., hlm. 16-18. 
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sebagai konstanta yang menyatakan nilai angka nyata atau merupakan 

alamat data dalam memori. 

Program PLC dapat dibuat dengan menggunakan beberapa cara 

yang disebut bahasa pemprograman. Bentuk program berbeda-beda sesuai 

dengan bahasa pemprograman yang digunakan beberapa merk PLC hanya 

mengembangkan program leader diagram dan kode mnemonik. 

Sebelumnya kita harus tau simbol simbol kotak NO dan NC dapat dilihat 

pada gambar 2.8. 

(a) (b)

a. Konvensional

b. Diagram ladder plc

 
Gambar 2.8. Simbol Kontak NO dan NC 

Sumber : Dokumentasi 

 

Instruksi dasar merupakan instruksi yang digunakan untuk 

membuat rakaian logik dari diagram tangga. Instruksi dasar ini ada 6 yaitu : 

LD, NOT, OUT, AND, OR, dan END. Fungsi dari instruksi-instruksi dasar 

tersebut dapat dilihat dibawah ini. 

1. LD 

LD atau singkatan dari Load, yang merupakan instruksi untuk memulai 

progaram garis atau blok pada rangkaian logic yang dimulai dengan kontak 

NO (normally open). Contoh intruksi LD dapat di lihat pada gambar 2.9 

pada hal 31. 
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00000 01000

LOAD OUTPUT

INPUT

OUTPUT

LADDER DIAGRAM TIMING DIAGRAM

 
                                                                                    Kode Mnemonik 

Gambar 2.9. Pengunaan Instruksi Load 
Sumber : Dokumentasi 

 

2. LDNOT 

Instruksi dasar LDNOT atau biasa disebut LDI berfungsi kebalikan dari 

LD untuk membentuk suatu kontak NC (normally close). Contoh intruksi 

LDNOT dapat dilihat pada gambar 2.10. 

00000 01000

LDNOT OUTPUT

INPUT

OUTPUT

LADDER DIAGRAM TIMING DIAGRAM

 
                                                                                    Kode Mnemonik 

. Gambar  2.10. Pengunaan Instruksi LDNOT 
Sumber : Dokumentasi 

 

3. OUT 

OUT merupakan instruksi untuk memasukan progaram koil output. 

Kontakïkontak dari masing-masing koil output dapat digunakan beberapa 

kali sesuai dengan yang diinginkan. Contoh intruksi OUT dapat di lihat 

pada gambar 2.11pada hal 32. 

Alamat Instruksi Operand 

00000 LD 00000 

00001 OUTPUT 01000 

Alamat Instruksi Operand 

00000 LDNOT 0000 

00001 OUTPUT 1000 
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OUTPUT

01000

SIMBOL OUTPUT PADA 

DIAGRAM LEADER

 

Gambar  2.11. Penggunaan Instruksi OUTPUT 
Sumber : Dokumentasi 

 

4. AND 

Instruksi AND ini digunakan untuk menguhubungkan dua atau lebih 

kontakïkontak input output secara seri. Contoh intruksi AND dapat dilihat 

pada gambar 2.12. 

   

00000 00001 01000

LADDER DIAGRAM  

                                                              Kode Mnemonik 

 

Gambar  2.12. Penggunaan Instruksi AND 
Sumber : Dokumentasi 

 

5. OR 

Instruksi dasar OR digunakan untuk menghubungkan dua atau lebih 

kontakïkontak input atau output secara paralel. Contoh intruksi OR dapat di 

lihat pada gambar 2.13. pada hala 33. 

 

 

Alamat Instruksi Operand 

0000 LD 00000 

0001 AND 00001 

0002 OUTPU 01000 
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00000

00001

01000

LADDER DIAGRAM  

                                                                                 Kode Mnemonik       

Gambar  2.13. Penggunaan Instruksi OR 
Sumner : Dokumentasi 

 

6. END  

Instruksi dasar END untuk menyatakan rangkaian kontrol yang dibuat 

telah berakhir. Instruksi END ini harus selalu dimasukan dalam penulisan 

program, karena apabila akhir rangkaian kontrol tidak dilengkapi dengan 

instruksi END, maka program tersebut tidak akan dieksekusi oleh CPU. 

Contoh intruksi END dapat dilihat pada gambar 2.14. 

 

00000 00001 01000

LADDER DIAGRAM

END

                                                                                                               Kode Mnemonik                 
 

Gambar  2.14. Penggunaan Instruksi END 
Sumber : Dokumentasi 

 

 

Alamat Instruksi Operand 

0000 LD 00000 

0001 OR 00001 

0002 OUTPU 01000 

Alamat Instruksi Operand 

0000 LD 00000 

0001 AND 00001 

0002 OUTPUT 01000 

0003 END 
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2.1.3.6. Timer Dan Counter 

A. Timer 

Timer berfungsi untuk mengaktifkan suatu keluaran dengan interval 

waktu yang dapat diatur. Pengaturan waktu dilakukan melalui nilai setting 

(preset value). Timer pada PLC omron diberi nomor dari 0 ï 127 (T0 ï 

T127). Instruksi timer ada dua macam yaitu Timer (TIM) dan ada Hight 

Timer (TIMH). Perintah TIM dan TIMH pada dasarnya sama, yaitu 

berfungsi sebagai time. Bedanya pada pengukuran waktu TIM mempunyai 

pulsa clock lebih panjang dibandingkan TIMH.  

TIM mempunyai pulsa clock sebesar 0,1 detik sedangkan TIMH 

mempunyai pulsa clock sebesar 0,01 detik. Timer tersebut akan bekerja 

jika diberi input dan mendapat pulsa clock. Untuk pulsa clock sudah 

disediakan oleh pembuat PLC. Berikut ini simbol ladder diagram timer 

dan contoh penggunaan timer pada gambar 2.15. 

 

TIM

N

SV

SIMBOL LADDER  TIMER

IR, SR, AR, DM, HR,LR, #

N ; TC Number

#

SV : Set Value (word, BCD)

Nomer Timer

Data Area Operand

 

Gambar  2.15. Simbol Ladder, nomer, dan data operand timer 
Sumber : Dokumentasi 
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00000

Tim 000

Tim 000

Tim

000

# 050

01000

01001

LADDER DIAGRAM

                                                                                                              Kode Mnemonik                    

Gambar  2.16. Contoh Penggunaan Timer 
Sumber :  Dokumentasi 

 

Saat input (00000) OFF, maka output 01001 akan OFF, tetapi pada saat 

input (00000) ON, maka timer mulai mencacah pulsa dari 0 sampai preset 

value. Bila timer sudah mencapai preset value (selama 5 detik) maka akan 

mengaktifkan output 01000 dan mematikan output 01001. Akan tetap 

apabila input timer (00000) OFF sebelum timer mencapai preset value 

maka timer akan OFF (reset) sehingga menyebabkan output 01000 OFF 

dan output 01001 ON kembali. Cara kerja gambar diatas dapat dilihat pada 

gambar di bawah ini : 

00000

TIM 000

01000

01001

2 dt 5 dt

 

Gambar  2.17. Diagram Waktu Timer 
Sumber : Dokumentasi 

Alamat Instruksi Operand 

0000 LD 00000 

0001 TIM 000 

  
#50 

0002 LD TIM  000 

0003 OUT 01000 

0004 LD NOT TIM 000 

0005 OUT 01001 
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B. Counter 

Pada PLC terdapat counter yang diberi nomor dari 0 ï 127 (C0 ï 

C127).  Penggunaan alamat counter ini digunakan secara bersama-sama 

dengan timer.
15

 Oleh sebab itu dalam satu program pemberian nomor 

counter tidak boleh sama dengan nomor timer. Cara kerja counter dan 

timer mirip, perbedaannya timer mencecah pulsa internal sedangkan 

counter mencecah pulsa dari luar. Ada dua sinyal input yang digunakan 

oleh counter yaitu sinyal pulsa dan sinyal reset. Simbol ladder counter 

dapat dilihat pada gambar 2.18. 

CNT

N

SV

SIMBOL LADDER  TIMER

IR, SR, AR, DM, HR,LR,#

N ; TC Number

#

SV : Set Value (word, BCD)

Nomer Counter

Data Area Operand

CP

R

 
Gambar  2.18. Simbol Ladder, nomor dan data area operand counter 

Sumber : Dokumentasi 

00000

CNT 000

CNT 000

CNT

000

# 004

01000

01001

LADDER DIAGRAM

00001

 

                                                               Kode Mnemonik 

Gambar  2.19. Contoh Penggunaan Timer 
Sumber : Dokumentasi 

 

                                                           
15

 Ibid., hlm. 76-78 

Alamat Instruksi Operand 

0000 LD 00000 

0001 CNT 000 

  
#4 

0002 LD 00001 

0003 LD CNT 000 

0004 OUTPUT 01000 

0005 LD NOT CNT 000 

0006 OUTPUT 01001 
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Seperti terlihat pada contoh penggunaan timer pada gambar 2.19. 

counter akan mulai mencacah pulsa dari 0 sampai preset value ketika 

terdapat sinyal input (00000) berupa pulsa dan kondisi input resetnya 

(00001) OFF. Bila cacahan counter sudah mencapai preset value yaitu 4 

kali maka counter akan mengaktifkan output 01000. Akan tetapi bila input 

reset (00001) ON sebelum counter mencapai prest value maka counter 

akan OFF  (reset) dan output akan OFF. Cara kerja gambar diatas dapat 

juga dilihat pada gambar 2.20. 

 

PENGHITUNG

(00000)

OUTPUT

(010000)

PULSA RESET

(00001)

 

Gambar  2.20. Diagram Waktu Counter 
Sumber : Dokumentasi 

 

2.1.3.7. Software CX-Programmer 

CX-Programmer merupakan salah satu bentuk perangkat lunak 

yang digunakan untuk memasukkan program ke dalam PLC. CX-

Programmer adalah software ladder untuk PLC, Ia beroperasi di bawah 

sistem operasi windows. Berikut ini adalah langkah-langkah yang 

diperlukan dalam membuat program PLC dapat dilihat pada hal 38. 

1. Instal Software CX-Programmer 
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Dalam penginstalan CX-Programmer perlu dipastikan untuk menutup 

semua windows program yang sedang aktif. Jika kita memiliki program CX-

Programmer versi lama, uninstal terlebih dahulu sebelum menginstal CX-

Programmer versi terbaru. CX-Programmer dapat diinstal mulai dari OS 

Windows 95/98/NT 4.0 SP 6, Windows 2000/Me, hingga Windows XP dan 

7. 

2. Membuka Projek Baru 

Dengan klik file, new untuk membuat file baru atau dengan cara meng-

klik [New] pada toolbar di CX-Programmer, seperti pada gambar 2.21. 

 
 

Gambar 2.21. Tombol [New] pada Toolbar  
Sumer : Dokumentasi 

 

 Lalu akan muncul pilihan seperti ini. Pilih tipe PLC yang digunakan 

dengan mengganti nama pada device type seperti yang terlihat pada gambar 

2.22. di bawah ini pada hal 39. 
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Gambar 2.22. Device Name 
Sumber : Dokumentasi 

 

Untuk mengubah jenis CPU PLC, dapat dilakukan melalui menekan 

tombol setting pada device type, maka akan keluar tampilan seperti gambar 

2.23. di halam berikutnya. Lalu pilihlah CPU type yang digunakan pada 

PLC. 

 
 

Gambar 2.23. Device Type Setting 
Sumber : Dokumentasi 
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 Setelah selesai, melakukan setting pada device type, lalu tekan tombol 

close. Lalu lakukan setting pada network type-driver, lalu cek port name dan 

disesuaikan dengan device manager pada komputer.seperti gambar 2.24. di 

bawah ini. 

 
Gambar 2.24. Network Setting 

Sumber : Dokumentasi 

 

Kemudian klik tombol OK. Maka akan muncul main window seperti 

pada gambar 2.25. disinilah leader diagram akan digambar. 

 
Gambar 2.25. layar software CX-Programmer 

Sumber : Dokumentasi 
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Fungsi masing-masing menu pada gambar 2.25. dijelaskan pada tabel 2.2 

di bawah ini. 

Tabel 2.2. Fungsi Main Window Software CX-Programmer 

Nama Fungsi 

Title Bar 
Memperlihatkan nama file yang telah di save pada CX-

Programmer 

Menus Untuk memilih item menu 

Toolbars 
Untuk memilih fungsi yang akan digunakan. Pilih [View] Ą 

[Toolbars], untuk memperlihatkan toolbars. 

Section Untuk membagi suatu program dalam beberapa block 

Project Workspace 

Project Tree 

Mengontrol program dan data. Dapat digunakan untuk 

meng-copy data dengan Drag and Drop di antara project 

yang berbeda atau dalam satu project. 

Ladder Window Layar untuk menulis dan mengedit diagram ladder 

Output Window 

¶ Menunjukkan error check 

¶ Menunjukkan hasil pencarian contacts/coils di list 

form 

¶ Menunjukkan error details ketika terjadi kesalahan 

dalam suatu file project. 

Status Bar 
Menunjukkan informasi seperti nama PLC, online/offline, 

lokasi cell yang aktif. 

Information Window 

Layar small window untuk menunjukkan basic shortcut keys 

yang digunakan di CX-Programmer. Munculkan pilih 

[View] -> [Information Window]. 

Symbol Bar 
Menunjukkan nama, alamat atau nilai, dan penjelasan dari 

simbol yang dipilih kursor. 

 

Kemudian setting main rack di bagian I/O Table and Unit Setup seperti 

yang terlihat pada gambar 2.26. pada hlm 42. 
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Gambar 2.26. IO Table and Unit Setup 

Sumber : dokumentasi 

 

3. Membuat Program 

Software CX-Programmer membebaskan pemakai untuk membuat 

program dalam bentuk diagram ladder atau mnemonic, tetapi akan lebih 

baik menggunakan program diagram ladder. Untuk membuat program 

dengan diagram ladder, dapat meng-klik simbol kontak, koil, garis atau 

fungsi seperti yang diinginkan yang terdapat pada toolbars seperti gambar 

2.27. 

 
Gambar 2.27. Simbol kontak, koil, garis atau fungsi pada PLC 

Sumer : Dokumentasi 

 

Pemakai juga dibebaskan untuk menggunakan operasi toolbar, atau 

shortcut keyboard, fungsi masing-masing toolbar dan shortcut ditunjukkan 

pada tabel 2.3. pada halaman 43. 
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Tabel 2.3. Fungsi masing-masing toolbar dan shortcut 

Menu/Comand Toolbar Shortcut 

Insert>Contact>Normally Open 
 

C 

Insert>Contact>Normally CloseD 
 

/ 

Insert>Vertical>Up  U 

Insert>Vertical>Down  V 

Insert>Horizontal  - 

Insert>Coil>Normally Open 
 

O 

Insert>Coil>Normally Closed 
 

Q 

Insert>Instruction 
 

I 

 

Lalu buat ladder diagram seperti gambar 2.28. di bawah sesuai logika 

yang diinginkan untuk di transfer ke PLC untuk dijalankan pada alat yang 

terhubung dengan PLC.
 16

 

 
 

Gambar 2.28. Membuat Program yang Diinginkan 
Sumber : dokumentasi 

 

                                                           
16

Ibid., hlm. 47-50. 
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2.1.4. OPC (OLE for process control) 

2.1.4.1. Pengertian OPC 

OPC adalah singkatan dari OLE (Object Linking and Embedding) 

for Prosess control yang berarti menghubungkan dan mencocokan objek 

untuk proses kontrol.  sebuah standar industri untuk antar konektivitas 

sistem
17

. Yayasan OPC (OPC Foundation) mengatur semua spesifikasi 

OPC. OPC menggunakan teknologi COM (Component Object Model) dan 

DCOM (Distributed Component Object Model), Microsoft untuk 

membolehkan suatu aplikasi menukar-nukar data dengan satu atau lebih 

komputer melalui arsitektur TCP/IP. OPC mendefinisikan sekumpulan antar 

muka umum. Dengan demikian, aplikasi akan mengambil data dengan 

format yang sama, tidak peduli asal datanya, apakah dari PLC, DCS, 

penganalisa, perangkat lunak aplikasi, meteran, atau lainnya. Jadi, OPC 

adalah solusi komunikasi yang tinggal diambil, dipasang dan dijalankan. 

OPC memungkinkan suatu program aplikasi untuk mengakses 

sumber data (peralatan ataupun database) dengan protokol yang sama dan 

konsisten. OPC bersifat seperti  software bus, dimana program aplikasi 

(OPC client) hanya perlu mengerti bagaimana mengambil data dari 

OPC data source (OPC server). Dimana OPC server ini dikembangkan oleh 

vendor masing-masing peralatan (missal PLC) yang diakses oleh komputer, 

                                                           
17 !ƎŦƛŀƴǘƻΣ άǘǳǘƻǊƛŀƭ ht/έ Σ ǘǳǘƻǊƛŀƭ ht/ ōƎƛŀƴ мΣ  
http://agfi.staff.ugm.ac.id/blog/index.php/2009/04/tutorial-opc-bagian 

pendahuluan/. Diakses pada tanggal 25 juni 2014 

 

http://www.opcfoundation.org/
http://agfi.staff.ugm.ac.id/blog/index.php/2009/04/tutorial-opc-bagian%20pendahuluan/.%20Diakses
http://agfi.staff.ugm.ac.id/blog/index.php/2009/04/tutorial-opc-bagian%20pendahuluan/.%20Diakses
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sehingga pengguna cukup membangun aplikasi OPC client sendiri untuk 

mengaksesnya, penjelasan tersebut dapat dilihat pada gambar 2.29.  

 
Gambar 2.29 Sistem Kerja OPC Client 

Sumber : dokumentasi 

 

OPC server seolah-olah seperti I/O driver yang dapat digunakan 

bersama oleh berbagai vendor. Berikut ini susunan layer dari suatu OPC 

server pada gambar 2.30. 

 

Gambar 2.30. Susunan Layer Pada OPC Server 
Sumber : Dokumentasi 

 

Spesifikasi OPC meliputi : 

a. Sekumpulan COM interfaces khusus yang digunakan oleh 

penulis client dan server. 

b. Pada masa sekarang, COM telah digantikan dengan API 

http://learnautomation.files.wordpress.com/2009/04/opc4.jpg
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c. Referensi terhadap sekumpulan OLE Automation dalam 

implementasinya, spesifikasi OPC berisi 2 set interfaces : custom 

interfaces dan automation interface seperti nampak pada gambar 

2.31. 

 

 

Gambar 2.31. Custom Interfaces Dan Automation Interface 
Sumber : Dokumentasi 

 

Sebuah OPC client berkomunikasi dengan OPC server 

melalui custom interface (misal dibuat dengan C++) dan automation 

interface (misal dibuat dengan SCADA) yang telah ditentukan. 

 

2.1.4.2. KEPserverEX V4.0 

KepserverEX merupakan OPC server yang menyediakan ratusan  

konektivitas langsung PLC yang berbeda, perangkat, dan sistem, dan 

berbagai macam aplikasi klien OPC, termasuk HMI dan lain-lain. Berikut 

penjelasan bagaimana menggunakan aplikasi KEPserverEX. 

a) Instal Program 

Dalam penginstalan KepserverEX versi 4.0 perlu dipastikan untuk 

menutup semua windows program yang sedang aktif. Jika kita memiliki 

program KepserverEX versi lama, uninstal terlebih dahulu sebelum 
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menginstal KepserverEX versi terbaru. KepserverEX dapat diinstal 

mulai dari OS Windows 95/98/NT 4.0 SP 6, Windows 2000/Me, hingga 

Windows XP, 7, dan windows 8 

b) Membuat Channel (saluran)  

Pilih program Start kemudian pilih KEPserverEX V4.0. seperti  

dijelaskan gambar 2.32.  

 
Gambar  2.32. Program Windows 

Sumber : Dokumentasi 

 

Maka akan tampil gambar seprti 2.33. selanjutnya pilih pada icon 

toolbar file kemudian new.   

 
 

  Gambar 2.33. Tampilan Utama KEPserverEX V4.0 
Sumber : Dokumentasi 
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c) Membuat channel baru 

Buat channel baru dengan cara doble click to channel Maka akan 

muncul tampilan seperti gambar 2.34., kemudian beri nama channel 

yang akan kita buat pada kotak yang telah disediakan. Kemudian  

NEXT. 

 
 

Gambar 2.34. Tampilan Membuat Channel Baru 
Sumber : Dokumentasi 

 

Kemudian akan tampil sesuai dengan gambar 2.35. selanjutnya kita 

memilih device driver yang akan kita gunakan seperti USB to serial 

RS232 dengan PLC CJ1 merek Omron, maka kita memilih Omron 

FINS Serial. Kemudian  NEXT. 

 
 

Gambar 2.35. Device Driver 
Sumber : Dokumentasi 


